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RKX-EVK-001 and A/D Converter 

ADC Evaluation Kit Manual 
 

The ADC Evaluation Kit is an evaluation kit for ROHM A/D Converter. The evaluation kit is based on the Cypress CY8CKIT-059LP 

Prototyping Kit featuring an integrated SoC based on ARM® Cortex®-M3 CPU with powerful digital peripherals. The evaluation kit 

comes with highly configurable RKX-A3 EVK-001 that provides easy to use hardware interface between the MCU and Digital in a 

plug-and-play fashion. Finally, the ADC Windows GUI, a powerful Windows-based desktop application, provides an intuitive 

graphical user interface to demonstrating high level device offerings and features such as visual display of real-time device, data, 

and ability to record device data. 

 

Definitions 

 

ADC Evaluation Kit 
Complete offering of the software, hardware, and firmware used for device evaluation 
purposes consisting of ADC Windows GUI, RKX-EVK-001, and CY8CKIT-059 Host 
Adapter Board 

RKX-A3-EVK-001 
Board specifically designed to easily interface with ADC Evaluation Board and the 
Cypress CY8CKIT-059LP Prototyping Kit 

RKX-EVK-001 Evaluation kit with RKX-A3-EVK-001, USB cable and ribbon cable 

ADC Evaluation Board Evaluation board with ADC 

Firmware Proprietary firmware running on microcontroller-based host adapters 

ADC Windows GUI 
ADC device evaluation software with graphical user interface (GUI) running in 
Windows OS (ROHM_EVK.exe) 

 

Acronyms 

 

ADC A/D Converter 

GUI Graphical User Interface 

PSoC Programmable System on Chip 
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1. Evaluation Kit Overview 

 

1.1. RKX-EVK-001 Contents 

 

 

Figure 1. RKX-EVK-001 Contents 

 

The Evaluation Kit (RKX-EVK-001) comes standard with the Cypress PSoC® 5LP Prototyping Kit plugged into RKX-A3-EVK-001, 

one micro-USB cable (3.3’ / 1M), and one 14-position ribbon cable (1.5’ / 457.20mm). The Evaluation Kit is designed to work 

seamlessly with the ADC Evaluation Boards, such as BU79100G-LA-EVK-001 that can be purchased separately.  

 

1.2. System Level Block Diagram 

 

The main components of the RKX- EVK-001 are the host platform (Cypress CY8CKIT-059) and the RKX-A3-EVK-001. The RKX- 

EVK-001 is designed to be interfaced seamlessly with the ADC Evaluation Board that can be purchased separately. The main 

purpose of the RKX-A3-EVK-001 is to provide a hardware interface between the host platform and the evaluation board. The Figure 

2 shows the simplified high-level block diagram of the RKX-EVK-001. 

 

 

Figure 2. High Level Block Diagram of the RKX-EVK-001 
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1.3. RKX-A3-EVK-001 

 

1.3.1. RKX-A3-EVK-001 Detailed Diagram 

 

The RKX-A3-EVK-001 is designed to easily interface with ROHM ADCs. By default, the board is populated to interface with Cypress 

CY8CKIT-059LP PSoC® prototyping platform and with ROHM standard evaluation boards featuring a 14-pin male header. The 

Figure 3 shows the main component of the RKX-A3-EVK-001.  

 

 

Figure 3. RKX-A3-EVK-001 Main Features 

 

1. 
TP4 - Test Point 4 for VBUS (Host) input voltage 
measurement 

7. SW3 – IO_VDD Select switch (VDD_SENSOR of VR2_OUT) 

2. 
LED2 – Orange LED is ON when VDD_SENSOR voltage 
is ON 

8. 
SW2 – 7-position rotary switch to configure VR1_OUT voltage: 
1 = 3.3V, 2 = 3.0V, 3 = 2.8V, 4 = 2.5V, 5 = 1.8V, 6 = 1.7V, 7 = 3.6V 

3. 
SW4 – Switch that connects VDD_SENSOR to 
VBUS/VR1_OUT 

9. TP3 – Test Point 3 for VDD_SENSOR voltage measurement. 

4. 
LED1 – Green LED is ON when VBUS (Host) Voltage is 
provided 

10. TP1 – Test Point 1 for GND reference voltage measurements 

5. 
SW1 – VDD_SENSOR select switch (VBUS or 
VR1_OUT) 

11. J6 – ADC Evaluation Board compatible header 

6. 
J7 / R64 – VDD_Sensor current measurement 
header/bypass. 

12. J5 – ADC Evaluation Board ribbon cable compatible header 
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1.3.2. Input / Output Power Configuration 

 

1.3.2.1. VDD_SENSOR Select 

 

The RKX-A3-EVK-001 gives users the flexibility to test devices at different VDD and IO_VDD input voltages as well as provides a 

way to interface devices with 5V platforms (E.G., Cypress CY8CKIT-059).   

 

The VDD Sensor Select circuitry is show in Figure 4. When RKX-A3-EVK-001 is connected to a host platform, the input voltage to 

the board is supplied on VBUS net and the green LED (LED1) will be ON. The VBUS voltage is then supplied as an input to the 

Voltage Regulator (VR1) and is connected the Single Poll Double Throw (SPDT) switch SW1. The purpose of the SW1 is to select 

the VDD voltage to the sensor that will be connected to the RKX-A3-EVK-001 (VDD_SENSOR). One option for VDD_SENSOR is 

the actual VBUS voltage. The second option is the output voltage from the VR1 voltage regulator (VR1_OUT). The default 

configuration of the RKX-A3-EVK-001 is to select the output voltage from the VR1 voltage regulator.  

 

NOTE: Care must be taken when switch SW1 is moved left to select VBUS voltage. For platforms like CY8CKIT-059 Prototyping 

Kit, the VBUS voltage can be as high as 5V. The overvoltage and potential permanent damage may be done to the devices in cases 

when 5V VBUS voltage is connected to VDD_SENSOR. 

 

 

Figure 4. RKX-A3-EVK-001 VDD Sensor Select 
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The VR1 voltage regulator is a variable output Low Dropout (LDO) linear voltage regulator. The output voltage of the VR1 is selected 

via rotary switch SW2. The SW2 switch has 7 positions as indicated on the schematic and on the printed circuit board itself. The 

switch SW2 can be rotated with a small flat screwdriver. By default, the RKX-A3-EVK-001 is shipped with switch SW2 in Position 

1. See Table 1 for details on how to select the output voltage using SW2. 

Table 1. Switch SW2 Voltage Select for different Switch Positions 

SW2 position 1 2 3 4 5 6 7 

VR1_OUT 
3.3V 

(default) 
3.0V 2.8V 2.5V 1.8V 1.7V 3.6V 

 

Following the voltage path from VBUS to the switch SW1 (from left-to-right in Figure 4), next comes switch SW4 (VDD_SENSOR 

ON/OFF switch). The purpose of the switch SW4 is to disconnect the VDD_SENSOR from the input voltage (VBUS). This can be 

useful when evaluation board needs to be unplugged and re-plugged again. By default, the switch SW4 is on the ON position (UP 

position when looked from above). When RKX-A3-EVK-001 is connected to a host platform, and the switch SW4 is turned ON the 

orange LED (LED2) will be ON. If the switch SW1 is connected to the output of the VR1 voltage regulator (VR1_OUT), the brightness 

of the orange LED will be proportional to the VR1_OUT voltage output. At default position of the switch SW2 (3.3V) the LED light 

will be bright and when the output voltage is selected to 1.8V or 1.7V using the switch SW2, the LED2 light will be dim. If orange 

LED (LED2) is completely OFF and green led (LED1) is ON, please ensure the switch SW2 is not turned to an intermediate position 

and is at one of the 7 positions shown in the Table 1. 

 

1.3.2.2. IO_VDD Sensor Select and VR2 Voltage Regulator 

 

The RKX-A3-EVK-001 provides a flexibility for selecting the IO_VDD source for the connected devices independent of the 

VDD_SENSOR if desired. As shown in Figure 5, the selection is made using the Single Poll Double Throw (SPDT) switch SW3. 

The default option for IO_VDD is to be connected to VDD_SENSOR rail. In this case, the IO_VDD voltage will follow the 

VDD_SENSOR voltage. The alternative selection of the SW3 switch would connect IO_VDD rail to the output of the VR2 voltage 

regulator.  

 

 

Figure 5. IO_VDD Sensor Select and VR2 Voltage Regulator 
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The VR2 voltage regulator is also variable output Low Dropout (LDO) linear voltage regulator. By default, it is configured to output 

3.3V using the preset values of R5 and R6 feedback resistors. However, the user can modify the output of the VR2 voltage regulator 

if desired by replacing the R6 resistor (13.7k) with another value (Table 2). 

Table 2. Voltage Regulator (VR2) Output Option 

VR2_OUT 3.3V (default) 3.0V 2.8V 2.5V 1.8V 1.7V 3.6V 

R6 13.7k 15.4k 17.4k 20k 34k 38.3k 12.4k 

R5 43.2k 43.2k 43.2k 43.2k 43.2k 43.2k 43.2k 

 

1.3.2.3. External Power Supply Connection  

 

In some cases, it may be required to provide an external voltage source for the VDD_SENSOR. To accomplish this, please remove 

R64 zero-ohm resistor. The positive terminal of the external power supply can then be attached to the test point TP3 and negative 

terminal can be attached to any GND location on the RKX-A3-EVK-001. One such convenient location is a test point TP1 show in 

Figure 6.  

 

 

Figure 6. External Voltage Source Recommended Connection 

 

1.3.3. VDD_SENSOR Current Measurements 

 

The RKX-A3-EVK-001 provides a convenient way to measure the current supplied on VDD_SENSOR power rail for testing and 

evaluation purposes. In order to measure the VDD_SENSOR current, it is recommended to remove R64 zero-ohm resistor and to 

connect a current meter across the J2 header that can be optionally populated for such a test. 

 

 

Figure 7. VDD_SENSOR Current Measurement Recommended Connections  
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1.3.4. IO_VDD Voltage Level Shifters 

 

The RKX-A3-EVK-001 comes standard with a pair of voltage level shifters (U1, U2) that are designated to shift the voltage levels 

of all digital I/O pins from the voltage level supported by the host platform (VBUS) and I/O Voltage provided to a sensor (IO_VDD) 

and vice-versa (Figure 8). This allows seamless interface between such platforms like Cypress CY8CKIT-059LP, where the I/O 

voltage can be as high as 5V. Please note the following information regarding the voltage level shifters: 

 

⚫ The acceptable input voltage range on the host side (B-side) is 2.3V to 5.5V 

⚫ The acceptable input voltage range on the device side (A-side) is 1.65V to 3.6V 

⚫ There is an internal 10k pull-up resistor on each side (A and B) of the level shifter. 

⚫ Level shifters have been verified to support I2C communication (up to 1000kHz) and SPI communication (up to 10MHz) with devices. 

For I2C communication, it is recommended to have additional pull-up resistors on SDA and SCL lines for faster transient switching. In 

many cases, there will be pull-up resistors on the evaluation board that come with devices. However, in other cases, it is recommended 

to populate 2.7k resistor at locations R88 (SDA) and R89 (SCL) on the RKX-A3-EVK-001. Once connected, the effective resistance 

would be 2.1k on each signal level (2.7k || 10k = 2.1k). 

⚫ It is possible to bypass the onboard level shifters if needed. This can be accomplished from removing the zero-ohm resistors on A and 

B sides of the level shifter and connecting level shifter bypass resistors (R50-R57). 

 

1.  

 

Figure 8. Voltage Level Shifters for I/O Signals 
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2. Interface with Evaluation Boards 

 

2.1. Physical Interfacing with ADC Evaluation Board 

 

The RKX-A3-EVK-001 comes with pair of headers that provides an easy way to connect to the standard ADC Evaluation Boards 

that come with 14-pin male header. One header is J5 14-pin male header, and another header is J6 18-pin female header (Figure 

9).  

NOTE: The 18-pin female header J6 is mechanically and electrically compatible with 14-pin male header found on ADC Evaluation 

Board and simplify alignment of both connectors relatively to each other. The pins 1, 2 & 17, 18 on J6 are not connected electrically. 

 

 

Figure 9. ADC Evaluation Board Interface Headers 

 

Thus, there are two ways to conveniently connect the standard ADC Evaluation Board to the RKX-A3-EVK-001 – one is using the 

14-pin ribbon cable plugged into J5 14-pin male header and another is by plugging the evaluation board directly into J6 18-pin 

female header (Figure 10). 

 

 

Figure 10. Interface with ADC Evaluation Board 
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3. Cypress CY8CKIT-059 Prototyping Kit 

 

3.1. Overview 

 

As was previously described, the ADC Evaluation Kit uses Cypress CY8CKIT-059 Prototyping Kit as the target host adapter platform 

due to the numerous advantages it offers including high performance, mixture of onboard digital and analog peripherals, support 

for Full Speed USB 2.0 connectivity, easy to use IDE with free license, and the low cost.  

 

 

Figure 11. Cypress CY8CKIT-059 Prototyping Kit 

 

When Cypress CY8CKIT-059 Prototyping Kit is shipped as part of the ADC Evaluation Kit, it comes pre-loaded with ROHM’s custom 

firmware, two 26-pin female headers soldered at locations J1 & J2, and is plugged into the RKX-A3-EVK-001 compatible male 

header J14 & J15 to provide the plug-and-play functionality out of the box (Figure 12). 

 

 

Figure 12. CY8CKIT-059 Plugged Directly in RKX-A3-EVK-001 

 

NOTE: The following content (3.1.1 -3.1.3) is provided directly from the manufacturer’s website: 

CY8CKIT-059 PSoC® 5LP Prototyping Kit with Onboard Programmer and Debugger (cypress.com) 

 

https://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit-onboard-programmer-and


 

 12/35 

User’s Guide 

© 2021 ROHM Co., Ltd. No. 64UG025E Rev.001 

Aug.2021 

3.1.1. Featuring PSoC 5LP 

 

“The CY8CKIT-059 PSoC 5LP Prototyping Kit features the CY8C5888LTI-LP097 device from the PSoC 5LP family. PSoC 5LP is 

the industry’s most integrated programmable SoC, combining high-precision and programmable analog and digital peripherals with 

an ARM® Cortex®-M3 CPU in a single chip. Process sensor signals with the 24-bit hardware DFB coprocessor, offload traditional 

CPU tasks to the CPLD-based Universal Digital Blocks and increase system performance with the peripheral-to-peripheral DMA 

controller. Integrate high-precision custom 20-bit Analog Front Ends with the Programmable Analog Blocks including opamps, PGAs, 

filters, comparators, SAR and Delta-Sigma ADCs and the industry's best CapSense touch-sensing solution.” 

 

3.1.2. Design for Flexibility 

 

“The kit provides access to all the PSoC 5LP device I/Os in a breadboard-compatible format. It features a micro-USB header for 

creating prototypes with Full Speed USB 2.0 connectivity. The kit is also designed with a convenient snappable form-factor, allowing 

users to separate the USB connector with the KitProg Programmer and Debugger from the target board to use them independently. 

Once done with the prototype, you're still left with a handy SWD programmer!” 

 

3.1.3. Low-Cost Programmer 

 

“The kit includes Cypress's KitProg Programmer and Debugger. KitProg can program and debug the target PSoC 5LP device via 

SWD when using PSoC Creator or PSoC Programmer. It supports bridging over USB-UART and USB-I2C interfaces and also 

provides access to Micrium μC/Probe to read and write memory on the target device. When snapped away, this tiny USB board 

can be used as a KitProg programmer and debugger with any PSoC 3, PSoC 4 or PSoC 5LP device. The KitProg firmware is 

provided as a bootloader image that can be upgraded to develop custom applications for it.” 

 

3.2. Firmware Pinout 

 

The interface between the Cypress PSoC microcontroller mounted on the CY8CKIT-059 Prototyping Kit (RKX-A3-EVK-001 headers 

J14, J15) and the ADC Evaluation Board on the evaluation board and either plugged directly to J6 (18-pin receptacle header) or via 

ribbon cable plugged into J5 (14-pin male header) on the RKX-A3-EVK-001 is shown in Table 3.  

 

Table 3. Physical Mapping of I/O Signals to the Cypress PSoC 5LP MCU 

Function in Firmware 
14-pin Male 
Header Pin J5 

18-pin 
Receptacle 
Header Pin J6 

RKX-A3-EVK-001 
PSoC Headers Pin 
J14, J15 

PSoC 5LP 
I/O Port 

RKX-A3-EVK-001 
Zero Ohm 

SPI (CSB) 2 4 J14-22 P1.5 R21 

SPI (SCLK) 5 7 J14-11 P12.5 R16 

SPI (SDATA) 9 11 J14-24 P1.7 R23 

SYNC/TRIG 10 12 J14-4 P2.3 R99 

Z_OUT 14 16 J15-19 P3.6 R29 

  

https://www.cypress.com/?mpn=CY8C5888LTI-LP097
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3.3. USB Driver  

 

Before connecting the RKX-A3-EVK-001 to the computer, it is highly recommended to install the ADC Windows GUI first using the 

installer file available for download at ROHM Semiconductor website: 

https://www.rohm.com/products/data-converter/a-d-converters#evalutionBoard 

 

If ADC Windows GUI is installer is used, a separate USB driver installation for Cypress CY8CKIT-059 Prototyping Kit is not required. 

Also, the Windows 10 operating system should automatically use the correct USB driver. However, earlier Windows versions are 

not able to automatically find the CDC ACM driver and the user will need to install the signed release inf file as describes in section 

3.3.1. 

 

3.3.1. USB Driver Installation Procedure 

 

1. Following the installation of the ADC Windows GUI, locate the folder cdc_acm_driver on the computer in the following location: 

\Users\(User Name)\Documents\ROHM_EVK\ ROHM-EVK-Firmware\Windows-dependencies\ ROHM-EVK-USB-driver\ cdc_acm_driver 

and verify that the presence of the following two files in the above-mentioned directory. 

◆ rokix_cdc_acm.cat 

◆ rokix_cdc_acm.inf 

 

2. Connect the Cypress CY8CKIT-059 Prototypic Kit to a computer using the provided micrco-USB cable (Figure 13). 

 

 

Figure 13. CY8CKIT-059 connected to PC 

  

https://www.rohm.com/products/data-converter/a-d-converters#evalutionBoard
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3. Open the Device Manager where you should find the “Evaluation Kit (Cypress)“ (Figure 14) 

 

 

Figure 14. Device Manager View 

 

4. Right-click the “Evaluation Kit (Cypress)” item, and choose “Update Driver Software …” A new window should open. Select “Browse my 

computer for driver software” (Figure 15) 

 

2.  

 

Figure 15. Update Driver Software - 1 
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5. Select “Let me pick from a list of device drivers on my computer”: (Figure 16) 

 

3.  

 

Figure 16. Update Driver Software – 2 

 

6. Choose “Next” (the selection in the list does not matter) (Figure 17): 

 

 

Figure 17. Update Driver Software - 3 
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7. Choose “Have Disk” (Figure 18) 

 

 

Figure 18. Update Driver Software - 4 

 

8. Then choose “Browse” and find the downloaded inf file and then select “OK”. You will be returned to an older pop-up window where you 

should select “Next” (Figure 19) 

 

4.  

 

Figure 19. Update Driver Software - 5 
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9. Windows will prompt you to install the driver, please select “Install” (Figure 20). 

 

 

Figure 20. Update Driver Software – 6 

 

10. Finally, please wait until the driver installation is complete. 

 

3.4. Firmware 

 

When Cypress CY8CKIT-059 Prototyping Kit is supplied as part of the ADC Evaluation Kit, it will come pre-loaded with the Firmware 

to interface with ADC Windows GUI. To upload the latest Firmware to the CY8CKIT-059 Prototyping Kit please follow the procedure 

outlined in the section 3.4.1. 

 

3.4.1. Firmware Update Procedure 

 

1. Download and Install the PSoC Programmer (Windows) from the Cypress’s website: 

https://www.cypress.com/products/psoc-programming-solutions 

5.  

2. Following the installation of the ADC Windows GUI, locate the folder on the computer in the following location: 

\Users\(User Name)\Documents\ROHM_EVK\ ROHM-EVK-Firmware 

and verify that the presence of a Firmware file with an extension .hex. 

6.  

3. Connect the CY8CKIT-059 Prototyping Kit into the USB port of the PC directly or with an USB extension cable A-Male to A-Female as shown 

in Figure 21 (note that firmware flashing is always done via USB-A PCB connector, not micro-USB connector on the other side of the board). 

 

Figure 21. CY8CKIT-059 Prototyping Kit Connected to the PC 

https://www.cypress.com/products/psoc-programming-solutions
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4. Open the PSoC Programmer application on your computer. Once opened, verify that Powered and Connected status messages are 

displayed in the status bar – the bottom right side of the window (Figure 22). If not, please verify the CY8CKIT-059 Prototyping Kit is properly 

plugged into the USB port. 

 

 

Figure 22. PSoC Programmer GUI 

 

If you received a Warning message “This Programmer is currently out of date”, or “The communication firmware on the kit does not match 

what is installed with the release of the PSoC Programmer”, click OK button to navigate to Utilities tab in the PSoC Programmer, and click 

the Upgrade Firmware button (Figure 23). When firmware upgrade is completed, go back to Programmer tab, and proceed to the next step. 

 

 

Figure 23. Programmer Firmware Update 

 

5. Next, select the firmware hex file mentioned in the step 2 by either pressing the Open Folder button or through the menu (File>File Load) or 

by pressing the F4 key (Figure 22). 

 

6. Next, flash the firmware on the CY8CKIT-059 Prototyping Kit by pressing the Down Arrow button or through the menu (File>Program) or by 

pressing the F5 key. (Figure 22) 
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7.  

If programming was successful, the Programming Succeeded message would be shown in the Results window (Figure 24).  

 

 

Figure 24. Firmware Upgrade Success Message 

 

7. You are now ready to use CY8CKIT-059 Prototyping Kit with the ADC Windows GUI! 

8.  
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4. Getting Started with ADC Windows GUI 

 

4.1. Introduction 

 

The ADC Windows GUI provides an easy to use graphical user interface demonstrating high level device offerings and features. 

Some of the features include: 

◆ A visual display of real-time device data 

◆ Ability to record device data onto a file 

ADC Windows GUI is compatible with Windows OS versions 7, 8 and 10. 

 

4.2. Setup 

 

4.2.1. Installation 

 

If ADC Windows GUI has not been installed already, it can be installed by downloading the latest installer file from the ROHM 

Semiconductor website: 

https://www.rohm.com/products/data-converter/a-d-converters#evalutionBoard 

Before running the ADC Windows GUI software, necessary USB serial drivers must be installed (if Windows does not install these 

drivers automatically). See section 3.3 for details. 

 

4.2.2. Configuration 

 

Please follow the following basic procedure to start using the ADC Windows GUI: 

 

◆ Attach the ADC Evaluation Board to the RKX-A3-EVK-001 either directly with the provided ribbon cable (Figure 10).  

◆ Connect the ADC Evaluation Kit to the PC with the provided micro-USB cable (Figure 13). 

◆ Launch ADC Windows GUI application. 

After the installation, the shortcuts to the ADC Windows GUI and to the ADC Evaluation Kit User’s Guide can be found on the desktop, in the 

Windows Start menu under ROHM_EVK folder, and in the installation directory: 

\Users\(User Name)\Documents\ROHM_EVK\ ROHM-EVK-Firmware 

◆ If Configuration update pop-up window is shown, click Yes to download the latest configurations from the server (Figure 25). 

 

 

Figure 25. Configuration Updated Popup Window 

  

https://www.rohm.com/products/data-converter/a-d-converters#evalutionBoard
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◆ Select the board configuration from the Board menu: 

e.g. BU79100G-LA-EVK-001 

◆ Select the desired configuration stream for the corresponding ADC from the Stream menu: 

e.g. BU79100G / ADC data (VA=3.3V, 10kSPS, non-inverted) 

◆ If the “Please enable streaming to activate Plotter movement!” – Pop-up window appears on the screen, enable data streaming with 

“Streaming” button. 

 

The plotter should now display real time output for ADC (Figure 26). 

 

 

Figure 26. Plotter view with measurements of BU79100G-LA displayed 

 

4.3. User Interface – Menu bar 

 

4.3.1. File – Menu 

 

The File menu contains only the option to exit the application. Selecting “Exit” will exit from the application. 
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4.3.2. Data – Menu 

 

 

 

The Data menu contains the options related to acquiring the data. 

 

4.3.2.1. Streaming 

 

The streaming menu is used for enabling / disabling device data streaming. 

NOTE: Data stream enabling / disabling may take a while, so please be patient. 

Shortcut: CTRL + S 

 

4.3.2.2. Logging 

 

The logging menu is used for enabling / disabling device data logging. The status bar will show the log file name. 

NOTE: It is normal to see a variation in the time intervals. Data is received at varying intervals and timestamps are given by the 

Windows GUI. 

 

Shortcut: CTRL + L 

 

4.3.3. Connection – Menu 

 

The ADC Windows GUI connects to the ADC Evaluation Kit via USB COM port. The ADC Windows GUI uses USB COM connection 

by default. When auto-connect is enabled, the USB connection is established automatically when the ADC Evaluation Kit is 

connected. “Windows BLE” and “Socket” are not supported by the ADC Evaluation Kit. 

NOTE: Changing connection may take a while, please be patient. 

NOTE: If you are having connection problems, “CTRL + R” can be used to refresh current connection. 

 

4.3.4. Registers – Menu 

 

This is not supported by the ADC Evaluation Kit. 

  



 

 23/35 

User’s Guide 

© 2021 ROHM Co., Ltd. No. 64UG025E Rev.001 

Aug.2021 

4.3.5. Settings – Menu 

 

 

 

4.3.5.1. Auto Connect USB 

 

When “Auto connect USB” is enabled, the ADC Windows GUI will automatically select the USB COM port for the connected device 

and connect to it. 

 

4.3.5.2. Auto config and register download 

 

When “Auto config and register download” is enabled, the ADC Windows GUI will automatically check and download the latest 

board and stream configurations. The user will be notified when there are new configurations available for download. 

 

4.3.5.3. Automatic streaming 

 

When “Automatic streaming” is enabled, the ADC Windows GUI will automatically start data streaming when the device stream is 

changed. 

 

4.3.5.4. COM port 

 

When there are multiple devices connected or there is some problem with the USB COM port selection, the COM port can be 

selected from the dropdown list. Before doing this the “Auto-connect” feature must be disabled. 

 

4.3.5.5. Reset connection 

 

If you are having connection problems, “Reset connection” can be used for refreshing the current connection. It also initializes the 

current data stream again. 

Shortcut: CTRL + R 

 

4.3.5.6. Paired BLE devices 

 

This is not supported by the ADC Evaluation Kit. 
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4.3.6. Stream – Menu 

 

 

The stream menu is used for selecting the device data stream which the application uses to receive data. When Raw data (4.4.1.1) 

is disabled, the "inverted" settings are enabled, and the ADC data is inverted and output. When Raw data is enabled, there is no 

difference between the "non-inverted" and "inverted" settings. 

NOTE: The ADC Windows GUI will store the last used stream configuration and it will be loaded in the next application startup. 

 

4.3.7. Board – Menu 

 

 

The available board configuration is ”BU79100G-LA-EVK-001”. 

 

4.3.8. View – Menu 

 

 

The View menu item provides different features that can be shown or hidden in the ADC Windows GUI. 

 

4.3.8.1. Sub-channel view & Digital Output in sub channel view 

 

The “Sub channel view” is enabled by default and also via View menu or CTRL+V keyboard shortcut, the plotter shows an additional 

side panel on the right which can be used to show/hide the sub channel view. It also has a column for the digital output of each sub 

channel which can be enabled with “Digital output in sub channel view” submenu item or CTRL+D keyboard shortcut. (Figure 27) 

NOTE: When you have a very high ODR (25.6 kSPS), the digital output can slow down the plotter’s performance. 
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Figure 27. Plotter view with Sub Channel View and Digital Output Enabled 

 

4.3.8.2. Events view panel 

  

When “Events view panel” is enabled, the  events will be show in the output window located below the plot window. (Figure 28). 

 

 

Figure 28. Events view panel output window  
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4.3.8.3. Reference line 

 

When the “Reference line” is enabled, the plotter shows an additional horizontal line that can help to compare the real time signal 

value against the referenced value (Figure 29). The line can be dragged up/down the plotter view by pressing and holding the left 

button mouse. The present value of the Reference line position is also shown in the Status bar (lower right corner of the window). 

To achieve a higher resolution / granularity when setting the reference line position, use the mouse scroll wheel to zoom into and 

out of the plotter window. 

 

 

Figure 29. Plotter view with reference line enabled. 

 

4.3.8.4. Show all board configurations 

 

The “Show all board configurations” sub menu item controls whether Board menu item lists all supported board configurations for 

all supported Host Adapters or only the relevant ones that are supported by the Host Adapter currently plugged in (4.3.7). 

 

4.3.8.5. Show ODR warning pop up window 

 

The ODR warning pop up window is shown anytime when the real time Output Data Rate (ODR) as measured by the ADC Windows 

GUI is significantly different from the nominal ODR set in the Stream. 
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4.3.9. Help – Menu 

 

 

 

4.3.9.1. About ROHM EVK 

 

The About ROHM EVK help menu shows the current ADC Windows GUI’s version and which Git commit it is from and when it has 

been built. It also shows the link to GitHub repository where the latest version can be downloaded from. 

 

4.3.9.2. About Host Adapter Board 

 

The About Host Adapter Board help menu is enabled when a host adapter board is connected. The provided information includes 

its firmware information (Protocol Version, Firmware Version), as well as the hardware information such as Board ID and Board 

Unique ID (UID) when available. 

 

4.3.9.3. GitHub Issues Tracker 

 

A link to the GitHub Issues shows information on ToDo items, feature requests, and bugs on the Windows GUI software as well as 

other firmware and software. 

 

4.4. User Interface - Tabs 

 

The functionalities of the ADC Windows GUI are divided between separate tabs. 

 

4.4.1. Plotter – Tab 

 

The Plotter in Figure 26 shows device data from the current stream. The Plotter has its own Streaming and Raw data buttons in 

order to change them quickly. (Figure 30).  

 

 

Figure 30. ADC Window GUI menu bar view.  

 

Data logging can be enabled/disabled easily with the button with the red circle icon. 

NOTE: When logging is enabled the red circle icon starts to blink. 
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When Auto scaling is enabled, plotter will auto scale the minimum and maximum values in the y-axis according to the device data. 

 

Show grid – enables data grid lines. The shortcut ”G” can also be used for this. 

NOTE: This may slow down the plotter’s performance. 

 

Pause – pauses the plotter. The shortcut “P” can also be used for this. 

 

Clear – clears all data points from the plotter. The shortcut “C” can also be used for this. 

 

FFT – turns on the Fast Fourier Transform (FFT) functionality of the plotter. More information can be found in section 4.4.1.6. 

 

Data range – this slider bar adjusts the amount of data points shown in the plotter.  

 

NOTE: At high data rates, the slider area of Data Range may flash red, indicating it is unable to draw all the samples received. The 

data will be averaged in order to fit into a screen. 

 

4.4.1.1. Raw data 

 

When raw data is disabled, SI units for data streams are visible and “inverted” settings is enabled: 

 

 

 

4.4.1.2. Zooming 

 

You can zoom in and out using the mouse scroll button or right mouse button + CTRL. 

NOTE: When zooming and “Auto scaling” is enabled, the Plotter will no longer perform auto scaling. In order to re-enable “Auto 

scaling” after zooming, Auto scaling button must be enabled again. 

 

4.4.1.3. Pausing 

 

You can pause with the “Pause” – button or with the shortcut “P”. The Plotter can also be paused to a certain a position using the 

left mouse button. 

 

4.4.1.4. Moving 

 

The position of the Data axis (y-axis) can be moved up and down using the right mouse button. 

 

4.4.1.5. Clearing 

 

You can clear all visible data points from the plotter with the “Clear” button. 

  



 

 29/35 

User’s Guide 

© 2021 ROHM Co., Ltd. No. 64UG025E Rev.001 

Aug.2021 

4.4.1.6. Frequency analysis 

 

The Plotter also has an FFT (Fast Fourier Transform) functionality to show frequency data. In Figure 31, a sine wave with a 

frequency of 200 Hz is input to ADC Evaluation Board. 

 

 

Figure 31. Plotter view with FFT functionality 

 

NOTE: The x-axis range for the plot starts from 0 Hz and ends in ODR/2 Hz . It is automatically adjusted if the ODR is modified. 

 

Also, it is possible to change the x-axis to logarithmic scale and the y-axis to dB scale(Figure 32). 

 

Figure 32. Plotter view with FFT functionality (logarithmic and dB scale) 
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4.4.2. Registers – Tab 

 

This is not supported by the ADC Evaluation Kit. 

 

4.4.3. BU79100G-LA-EVK-001 Connection – Tab 

 

This tab describes how to connect RKX-A3-EVK-001 and BU79100G-LA-EVK-001. 

 

 

Figure 33. 4.4.3. BU79100G-LA-EVK-001 Connection tab view 
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4.5. User Interface - Status bar 

 

 

 

The status bar shows the following information: 

- Current connection interface (USB / Bluetooth) (4.3.3) 

- COM port (4.3.5.4) 

- The status of the communication (Streaming, Connected, Disconnected, No Data) 

- Real-time Output Data Rate (ODR) information 

- Stream Configuration (4.3.6) 

- Board Configuration (4.3.7) 

- Reference line value (4.3.8.3) 

NOTE: Bluetooth communication is not supported by the ADC Evaluation Kit. 

NOTE: It is normal to see a slight variation in the ODR value. Data is received at varying intervals and the ODR is calculated when 

ADC Windows GUI receives the data from the used connection layer. 

 

4.6. User Interface - Pop-up windows 

 

The application makes use of pop-up windows to notify the user about important actions. This section provides detailed information 

about pop-up windows. 

 

4.6.1. No data pop-up window 

 

 

 

“No data received” pop-up is showed when streaming has been started, but no data is received. The problem could be invalid board 

configuration selection or some connection problem (see section 5.4.2 for details). 

 

4.6.2. Streaming pop-up window 

 

 

 

Streaming pop-up window is shown in the Plotter view to notify the user about data stream enabling. Streaming can be enabled 

with the specific “Streaming” – button, from Data/Streaming – menu or with the shortcut “CTRL + S”. It is also possible to enable 

Automatic streaming (4.3.5.3) 
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4.6.3. ODR has not reached the target value pop-up window 

 

 

 

The ODR warning pop up window is shown anytime when the real time Output Data Rate (ODR) as measured by the ADC Windows 

GUI is significantly different from the nominal ODR set in the Stream. It can occur when the USB cable is either damaged or of a 

low quality. 

 

4.7. Shortcuts 

 

The ADC Windows GUI has many keyboard shortcuts: 

 

CTRL + L Enable/disable logging 

CTRL + S Enable/disable streaming 

CTRL + R 
Reset used connection and data streaming (disconnect and connect when having connection 
problem). Re-enable the Streaming when connection is established. 

CTRL + E Show events view 

CTRL + V Show subchannel view 

CTRL + D Show digital output in sub channel view (works only if subchannel view is enabled) 

CTRL + C Clears the current points in plotter view 

CTRL + B Show all board configuration 

CTRL + O Show ODR warning pop up window 

G Shows the grid in the plotter   

P Pause plotter 

SHIFT + L Hide/show reference line 
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5. Troubleshooting and known issues 

 

5.1. ODR accuracy and Timestamping 

• With ADC Windows GUI, timestamping is done on a PC and it is not accurate with high ODRs. This influences the delta time statistics. 

• The real-time ODR shown in the ADC Windows GUI may show fluctuating and be off the nominal ODR value. If the value is within ~ 

10% of the nominal value, the behavior is normal and can be due to combination of factors such as fluctuation of the actual sensor ODR 

due to internal oscillator jitter, as well as the timestamping error mentioned above. For cases where the ODR value is either significantly 

lower or higher than the nominal value, and “ODR has not reached the target value” pop-up window is shown, see section 4.6.3 for 

details. 

 

5.2. USB Communication Troubleshooting 

 

• USB communication may miss device data samples, or the USB connection is lost randomly: Use good quality USB cables which are 

USB certified. 

 

• USB performance is not good on all Windows machines. The root cause is yet unknown. 

 

5.3. ADC Windows GUI  

• If an error message shown in Figure 34 appears, the Windows .NET installation is not up to date. Please run Windows update or install 

the required .Net version manually to resolve the issue. 

 

Figure 34. A Windows error message which indicates that Windows .NET installation is out-of-date. 

 

• Sometimes after installation the desktop shortcuts will not work. To overcome this, please uninstall and reinstall the application again to 

a different destination directory. 

 

• In case of connection problems or application crash, please check the error log file of the ADC Windows GUI: 

\Users\(User Name)\Documents\ROHM_EVK\ROHM-EVK-GUI\errorlog.txt.  
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5.4. ADC Evaluation Kit Communication Issues Troubleshooting 

 

The communication between the ADC Windows GUI may not work for number of reasons. The issue can be related to hardware, 

software, or both. The following steps can used as a guidance to troubleshoot such issues. 

 

5.4.1. ADC Windows GUI Status Bar “Status: Disconnected”  

 

 

If “Status: Disconnected” is shown in the Status bar, please check the following: 

 

 

Figure 35. ADC Evaluation Kit status: LED1, SW4, LED2, LED1 (CY8CKIT-059) must be ON 

 

1. The blue LED1 (CY8CKIT-059) should be constantly ON and not blinking (Figure 35) 

◆ If the blue LED1 (CY8CKIT-059) is blinking, the CY8CKIT-059 is not programmed with the Firmware. Please program the latest 

Firmware (see 3.4.1 for details). 

◆ If the blue LED1 (CY8CKIT-059) is turned OFF, please try the following:  

A. Check the micro-USB cable is securely connected to CY8CKIT-059 Prototyping Kit and to the USB port on the PC 

(Figure 13) 

B. Connect to a different USB port on the PC. 

C. Replace micro-USB cable with a new, high quality, USB certified cable. 

 

2. The green LED1 (Figure 35).  

◆ If the green LED1 is OFF but blue LED1 (CY8CKIT-059) is ON: 

Ensure the CY8CKIT-059 Prototyping Kit is securely connected to the RKX-A3-EVK-001. 
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5.4.2. ADC Windows GUI Status Bar “Status: No data”  

 

 

 

If connection status as indicated in the status bar says, “No data”, the ADC Windows GUI does not receive the data. To troubleshoot 

the issue, please check the following: 

 

1. The orange LED2 should be ON (Figure 35). If orange LED2 is OFF, check the following: 

◆ Check if the SW4 is in the ON position (i.e., moved up as seen from above) (Figure 35).  

◆ If the SW4 is ON, check that the 7-position rotary switch SW2 (Figure 3) is not stuck in the intermediate position. The switch can be 

turned with a small flat screwdriver (see Table 2 for details). 

 

NOTE: When using the ADC Windows GUI and the SW4 in not in the correct position, the Help menu item About Host 

Adapter Board would still work properly because the information about the host adapter firmware is read out from the 

CY8CKIT-059 Prototyping Kit. 

 

2. The orange LED2 is ON: 

◆ Evaluation board is securely connected to the RKX-A3-EVK-001 either directly or with the ribbon cable (Figure 10). 

◆ Press CY8CKIT-059 Reset Button (Figure 35). Wait few seconds. If status changes to “Connected”, press “Streaming” button. 

◆ Unplug the CY8CKIT-059 Prototyping Kit from the PC and plug back. Wait few seconds. If status changes to “Connected”, press 

“Streaming” button. 

◆ Close the ADC Windows GUI. Unplug the CY8CKIT-059 Prototyping Kit from the PC. Plug the CY8CKIT-059 Prototyping Kit and restart 

the ADC Windows GUI. 
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N o t e s  

The information contained herein is subject to change without notice. 

Before you use our Products, please contact our sales representative and verify the latest specifica-
tions :

Although ROHM is continuously working to improve product reliability and quality, semicon-
ductors can break down and malfunction due to various factors.
Therefore, in order to prevent personal injury or fire arising from failure, please take safety 
measures such as complying with the derating characteristics, implementing redundant and 
fire prevention designs, and utilizing backups and fail-safe procedures. ROHM shall have no 
responsibility for any damages arising out of the use of our Poducts beyond the rating specified by 
ROHM.

Examples of application circuits, circuit constants and any other information contained herein are 
provided only to illustrate the standard usage and operations of the Products. The peripheral 
conditions must be taken into account when designing circuits for mass production.

The technical information specified herein is intended only to show the typical functions of and 
examples of application circuits for the Products. ROHM does not grant you, explicitly or implicitly, 
any license to use or exercise intellectual property or other rights held by ROHM or any other 
parties. ROHM shall have no responsibility whatsoever for any dispute arising out of the use of 
such technical information.

The Products specified in this document are not designed to be radiation tolerant.

For use of our Products in applications requiring a high degree of reliability (as exemplified  
below), please contact and consult with a ROHM representative : transportation equipment (i.e. 
cars, ships, trains), primary communication equipment, traffic lights, fire/crime prevention, safety 
equipment, medical systems, servers, solar cells, and power transmission systems.
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equipment, nuclear power control systems, and submarine repeaters.

ROHM shall have no responsibility for any damages or injury arising  from non-compliance with 
the recommended usage conditions and specifications contained herein.

ROHM has used reasonable care to ensure the accuracy of the information contained  in this 
document. However, ROHM does not warrants that such information is error-free, and ROHM 
shall have no responsibility for any damages arising from any inaccuracy or misprint of such 
information.

Please use the Products in accordance with any applicable environmental laws and regulations, 
such as the RoHS Directive. For more details, including RoHS compatibility, please contact a 
ROHM sales office. ROHM shall have  no responsibility for any damages or losses resulting 
non-compliance with any applicable laws or regulations.

When providing our Products and technologies contained in this document to other countries,  
you must abide by the procedures and provisions stipulated in all applicable export laws and 
regulations, including without limitation the US Export Administration Regulations and the Foreign 
Exchange and Foreign Trade Act.

This document, in part or in whole, may not be reprinted or reproduced without prior consent of 
ROHM.
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